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INTRODUCTION  

The ExamView® Assessment Suite 5.1 (including the Test Generator, Test Manager, 
and Test Player) is a comprehensive solution for creating, administering, and scoring 
tests. With the new version, it is easier than ever to prepare paper and online tests. 
The software includes many features to save you time and generate information to 
assess and improve student performance.  

 
Use the ExamView Test Generator to… 

• Create a paper test in less than five minutes.  

• Print multiple versions of the same test.  

• Enter your own questions. 

• Prepare an online test, study guide, and worksheet. 

• Upload tests to WebCT and Blackboard. 

 
Use the ExamView Test Manager to… 

• Create a class roster. 

• Automatically score a paper test using a scanner. 

• Automatically score an assignment using response devices.* 

• Administer and score an online test. 

• Prepare a variety of useful class and student reports. 

*Professional Edition only 

 
Our mission is to enhance the learning process by providing superior products for 
students and educators. We believe that the ExamView Assessment Suite can truly 
enhance your classroom experience. 
 
One of the reasons our software is so widely used in classrooms is that we include 
educators and students in the design process. We invite you to share your experiences 
and feedback with us so we can make our products even better. Please email your 
comments to support@fscreations.com. 
 
To learn more about our products, visit our website at www.fscreations.com. 
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System Requirements 
To use the ExamView Assessment Suite v.5.1, your computer must meet or exceed the 
following requirements: 
 
• PC with Pentium II 120 MHz or higher processor 

• Microsoft Windows 98 or later operating system 

• 32 MB available memory for application (64 MB recommended) 

• 24 MB of available hard drive space 

• CD-ROM drive (for installation from disc) 

• Monitor capable of displaying 16-bit color with 800 x 600 resolution 

• Mouse (or another pointing device) 

• Internet connection to access the test-hosting features 

 
 
 
Note:  

• The ExamView Assessment Suite includes a separate program called the 
ExamView Test Player that you can use to deliver online tests on your local 
area network. The system requirements are the same as those shown above 
except that the application requires a minimum of 16 MB available memory 
for the application and 8 MB of hard drive space. 

• Some ExamView Assessment Suite features require hardware devices such 
as response pads and scanners. These devices may have higher system 
requirements than those listed here. Check your hardware manufacturer’s 
user guide or website to verify that your system meets these requirements. 
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Installation Instructions 
Follow these steps to install the ExamView Assessment Suite. The installer will create 
an ExamView folder and these subfolders: Banks, Tests, Scanners, and Classes. If you 
received the software from a publisher, the installer will automatically copy the 
publisher-supplied question banks to a new folder within the Banks folder. 
 
 
1. Insert the ExamView disc into the CD-ROM drive of your computer.  

 If the autorun feature is enabled on your computer, a window will automatically 
appear on your screen. Click the Install button and skip to step 5. If the autorun 
window does not appear, proceed to step 2. 

2. Click the Start button and choose Run. 

3. In the Run window, type d:\setup.exe, replacing d with the drive letter that 
corresponds to the drive where the setup file is located. 

4. Click the OK button. 

5. Follow the instructions that appear on your screen. 
 
Note: To uninstall the ExamView software, choose Settings – Control Panel from 
the Start menu. Select Add or Remove Programs. Removing the program does not 
delete any banks or tests. You must manually remove those files. 
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Getting Started 
After you complete the installation process, follow the instructions below to start the 
software. Start the ExamView Test Generator if you want to create a test, open an 
existing test, create new questions, or work with a question bank. Use the ExamView 
Test Manager to create a new class roster, assign an online test to a class, get results 
from an online test, score a paper test using a scanner, or print a report. 
 
ExamView Test Generator 

1. Click the ExamView Test Generator shortcut on 
your desktop. If you do not have a shortcut, click 
the Start button. Highlight the Programs menu and 
locate the ExamView Pro Test Generator folder. 
Select the ExamView Test Generator option. 

2. The first time you run the software, the program 
prompts you to enter your name, school/institution 
name, and city/state. Enter the requested 
information. 

3. Choose one of the options in the Startup menu.  

Each time you run the ExamView Test Generator program, the program displays 
the Startup menu. You can choose to create a test using the Test Builder or enter 
your own questions using the Question Bank Editor. 

  

  

Use the 
ExamView Test 
Generator to 
create a test or 
work with a 
question bank. 
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ExamView Test Manager 

1. Click the ExamView Test Manager shortcut on your 
desktop. If you do not have a shortcut, click the 
Start button. Highlight the Programs menu and 
locate the ExamView Pro Test Generator folder.  

2. Choose one of the options from the Startup menu.  

Each time you run the ExamView Test Manager 
program, the program displays the Startup menu. 
You can choose to start a new class or open an existing class. 

 

 
 
Help Topics 

Detailed help instructions are always available if you need assistance using the 
ExamView software. Click the Help button or choose the Help Topics option from the 
Help menu to view step-by-step instructions. If you have trouble while you are working 
with the software, you may want to review the troubleshooting tips. 

Use the 
ExamView Test 
Manager to 
assign an online 
test, get results, 
or print reports. 
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CREATE A TEST  

The ExamView Test Generator program provides all the tools you need to create a 
paper test or an online test from your own questions or from those provided by a 
publisher. You can use the QuickTest Wizard to select the questions for a test, or you 
can use one or more of the other question selection options.  

 

After you create or build a test, you can change the instructions, reorder the 
questions, change the layout, print the test, or publish an online test. 

 
 
Use the QuickTest Wizard 
If you want to create a test quickly with randomly selected questions from one or 
more question banks, use the QuickTest Wizard. The wizard guides you through the 
step-by-step process of selecting questions for a new test. 
 
To create a test with the QuickTest Wizard… 

1. Launch the ExamView Test Generator. A startup 
window with several options will appear. Choose the 
Create a new test using the QuickTest Wizard 
option. 

2. Name your test. 

3. Select the question banks from which you want to choose questions. 

4. Identify how many questions of each type you want on your test and click the Finish 
button. 

 
That’s all there is to it! If you want, you can customize the appearance of your test 
using the many formatting options or you can select additional questions.  
 

 

You can also click 

the  button in 
the toolbar to start 
the QuickTest 
Wizard. 
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Build a New Test 
The ExamView Test Generator offers several question selection options to create a 
new test. You can use the QuickTest Wizard or one of the other six options. The option 
you choose depends on your particular needs. For example, you can select questions 
by viewing the actual questions and deciding which ones to include on your test. Or, 
you can select questions by learning objective or standard. 
 
To build a new test… 

1. Launch the ExamView Test Generator. A startup 
window with several options will appear. Choose the 
Create a new test option. 

2. Name your test. 

3. Choose one of the question selection options from 
the Select menu, or click the corresponding toolbar button.  

Select Randomly - Choose this option if you want to select questions 
randomly. You can choose how many questions you want for each question 
type (e.g., multiple choice, true/false, short answer, etc.). 

Select from a List – If you have a printout of your question banks, you can 
manually review the questions and choose the ones you want to include on a 
test by writing down the question numbers. Then, use this option to select the 
question numbers from a list. 

Select While Viewing – Use this selection method if you want to view the 
questions and make your selections one at a time while viewing them. 

Select by Standard – If your questions include learning objectives, local 
standards, state standards, or national standards, use this option to easily 
select questions based on this information. 

Select by Criteria – Choose this option to select questions that match criteria 
you enter. For example, you can select all of the multiple choice questions 
that cover a certain topic and include specific keywords. 

Select All – Choose this option if you want to quickly select all of the questions 
in a bank or group of banks. 

You can also click 

the  button in 
the toolbar to 
create a new test. 
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4. After you choose a question selection option, identify which question banks you 
want to use to create the test.  

Highlight one or more question banks and click the Select button. The question 
banks you choose appear in the lower portion of the window. Click the Next button 
to move to the next step.  

Note: If the question bank(s) you want does not appear in the list, click the Folder 
button to locate the question bank(s). 

 

 

5. Use the options provided to select the questions 
that will appear on your test. 

Depending on which question selection option you 
chose, the ExamView Test Generator displays a 
window with the options you need to build a test. 

6. Change the appearance of the test, print the test, 
or publish it online. 

7. Save the test. 

 

If you need help 
using any of the 
selection options, 
click the Help 
button for detailed 
instructions. 
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Customize the Appearance of a Test 
ExamView Test Generator includes numerous features that allow you to customize the 
appearance of a test to your exact specifications. A few of the more popular options 
are listed here, but you can refer to the help topic Customizing the Appearance of a 
Test for a complete list. 
 
Answer Space 
Depending on how your students will complete the test, you can turn on or off space 
for answers. For example, if you want your students to write the answers on the test 
next to each question, you can provide space to do so. If your students will be using a 
bubble sheet or a separate piece of paper, you can show only the questions. Choose 
Layout from the Test menu. Set the corresponding options in the Leave Answer Space 
for area of the layout window. 
 
 
Reordering Questions 
Changing the order of questions is a snap. Just choose 
Reorder from the Question menu, and you can drag 
and drop the questions to your liking. Note, however, 
that questions must remain grouped by question type. 
You cannot move a single true/false question to a 
position after the multiple choice questions. Instead, 
you must move the entire group of true/false 
questions. 
 
If you want to scramble the questions, choose 
Scramble from the Question menu. From there, you can choose to scramble sections, 
questions, and the answer choices in multiple choice and multiple response questions. 
 
 
Replace Font 
If you want to change the font of your entire test, choose Replace Font from the Edit 
menu. Select the fonts and sizes you want to use, and click the Replace All button. All 
questions in your test will instantly update with the newly selected font choices. 
 
Note: If you use the Replace Font option to replace a font, it is best to replace one 
font (e.g., Times New Roman) with another (e.g., Arial). Do not choose to replace all 
fonts with another font. This could cause unintended results such as replacing symbols 
or other special characters (e.g., Symbol). 
 
 
Adjust Multiple Choice 
Do you need to alter a multiple choice test for a special-needs student? Choose Adjust 
Choices/Columns from the Question menu to adjust your test. You can instantly 
reduce the number of choices in all of your multiple choice questions.  
 

You can manually 
reorder or scramble 
questions. Also, 
when you print a 
test, there is an 
option to scramble 
the questions. 
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Layout and Style 
Several state and national test styles are built into the ExamView Test Generator. 
Instantly format your test by choosing a style from the Style Gallery. For example, if 
you want to format your test to look like the PSAT, choose Style Gallery from the Test 
menu. Select the PSAT option and click the OK button. 
 
If you do not see a style that suits you in the Style Gallery, you can customize the test 
with the Layout and Style commands. Choose Layout from the Test menu, and set the 
layout options. Then click the Style tab and choose your fonts and styles. The figure 
below shows an example of a test with a customized bubble sheet style. 
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Print a Paper Test 
After you create or open a test, you can print a paper test in just a few simple steps. 
When you choose to print a test, the ExamView Test Generator prints the test and 
the answer key exactly how it appears on screen.  
 
To print a test… 

1. Choose Print Test from the File menu, or click the  toolbar button. 

2. Set the print options. 

If you choose 2 or more versions of the test, you can choose to scramble the 
questions using several options. If the test includes dynamic questions, the 
ExamView Test Generator can calculate new values for each test. 

As part of the test, you can print an answer strip to make it easier to score paper 
tests and a version map that identifies how questions align on each version of a 
test. 

Note: To print a bubble answer sheet, select the Print Bubble Form option from 
the File menu. Refer to the Print a Bubble Form section in this user guide for 
further details. 

3. Click the OK button. 
 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 12   

Print a Bubble Form 
Using either the ExamView Test Generator or ExamView Test Manager, you can print 
bubble forms to accompany your test. These forms are compatible with the plain 
paper scanning feature of the ExamView Assessment Suite Professional Edition. 
Refer to the Plain Paper Scanning section of the Score Paper Tests with a Scanner 
topic in this user guide. 
 
To print a bubble form… 

1. Choose Print Bubble Form from the File menu. 

2. Select the form that best fits your assessment needs. 

When highlighted, a description of the selected form will be displayed on the right. 
 

Note: Visit our website (www.fscreations.com) to download additional forms. 

3. Click the OK button. 
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Publish an Online Test 
The ExamView Test Generator lets you publish a test in a variety of online formats. 
Regardless of the online testing option you choose, the steps to build a test are the 
same as those you use to create a paper test. The online testing options are listed 
below. 
 
Online testing options… 

• Create an online test on your local area network (LAN). 

• Publish a test using the ExamView Learning & Test Center. 

• Save the test as an HTML document that you can post to your own website. 

• Export the test for use with your WebCT or Blackboard course management 
system. 

• Publish a test to a third party’s website.  

 
The online testing format that you choose depends on your specific needs. Refer to 
the other sections in this manual for a complete description of the various options. 
Detailed instructions are available to guide you through the process of publishing an 
online test. 
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ENTER YOUR OWN QUESTIONS  

When you build a test using the ExamView Test Generator, you do so by selecting 
questions from question banks. A question bank (or bank) is a collection of questions 
and all of the related items (pictures, equations, learning objectives, standards, etc.) 
stored in one file. Each question bank may contain up to 250 questions, but you can 
have an unlimited number of banks. Typically, questions are organized into banks by 
chapter or lesson. 

 

Using the ExamView Test Generator, you can… 

• Enter new questions or edit existing questions. 

• Copy and paste questions from another source. 

• Import questions from Word or an RTF file (with the EV Import Utility). 

 

IMPORTANT: You can create a new question or edit a question while building a test. 
However, editing a question after it is included on a test does not change the original 
question in the question bank. You must edit questions or add new ones in a question 
bank to make those questions available when you build your tests. 

 
 
Question Bank Basics 
If you have not used the ExamView Test Generator to create your own questions, 
there are a few things to consider before you get started. For example, you can 
include more information than just the question (e.g., answer, learning objective or 
standard, student feedback, etc.). Take a few 
moments to review the information presented here 
before you begin the next section. 
 
 
Question Types 
When you create your own questions, you can include 
one or more of the following question types. 
 

True/False 
Modified True/False 
Multiple Choice 
Multiple Response 
Bimodal 

Yes/No 
Numeric Response 
Completion 
Matching 
Short Answer 

Problem 
Essay 
Case 
Other 

 

You can use a 
bimodal question 
as a short answer 
or a multiple choice 
question on a test. 
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Question Information 
Questions can include optional information that is useful 
when creating a test. For example, you can include 
learning objectives (or standards) and then select 
questions based on those objectives. You can also use this 
information to generate class and student reports. You 
can enter any or all of the following information with 
each question. 
 
Difficulty 
Reference 
Learning Objective 
National Standard 

State Standard 
Local Standard 
Miscellaneous 

Topic 
Keywords 
Notes 

 
 
Student Feedback 
If you use the ExamView Assessment Suite to deliver online tests, you can include a 
rationale and student feedback for each objective-based (e.g., multiple choice) 
question. As a result, you can set up your online tests to display feedback for incorrect 
responses.  
 

 
 
 
 
 
 
 
 
 
 

 

Use the pipe ( | ) 
character to enter 
more than one 
data element 
such as a state 
standard – 
MA3-1.2 | MA4-1. 

For paper and 
online tests, you 
can print a report 
with the rationale 
for each item a 
student answers 
incorrectly. 
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Narratives 
A narrative is a table, a descriptive passage, a special instruction, a picture, or other 
information that can be attached to (or linked to) one or more questions. All questions 
linked to the same narrative print together as a group on a test. Possible uses for a 
narrative include a reading passage, map, chart, or photo. 

 

Images 
You can easily insert an image (e.g., graph, map, photo, etc.) into a question or an 
answer. Or, you can copy and paste an image from another program. Whichever option 
you use, be sure to consider the size and readability of 
the image.  

 

Color images and photos can use a lot of memory that, 
in turn, increase the size of the test or question bank 
file. For example, a single color photo can be 1-2 MB. 
For paper tests, the size of an image is not that critical. 
However, the image size does affect online tests. 
Imagine students downloading a test via the Internet 
that includes three or four photos. If you use color 
images, use the lowest possible resolution.  

 

If you plan to include an image in a question, you should check the image for 
readability. Can you read the information on your screen and on paper? If you create 
your own art, use a larger font for text that appears as part of an image.  For best 
results and smaller file sizes, use black and white or 256-color images. 

 

Other Issues 
If you create your own questions or edit existing questions, consider these additional 
guidelines.  
 
When you create your own questions… 

• Do not write questions that refer to another question or depend on a particular 
question order. Remember that you can scramble questions on a test. And, if 
you randomly choose questions, you may not get all of the questions you need.  

• Use tables, not tabs, if you need to create tabular material. Tables work much 
better, especially for online tests. 

• Use standard fonts (e.g., Times New Roman, Arial, etc.). If you use other fonts, 
you may have difficulty sharing the question banks with someone who does not 
have the fonts you used. This can be a problem for online tests too. 

• For multiple choice and multiple response questions, be sure to set the scramble 
options for questions that include choices such as All of the above or None of 
the above. You would not want one of these choices to appear as choice a or b. 

• Do not worry about entering the instructions for the questions. ExamView Test 
Generator automatically includes the instructions when you create a test. 

You can edit a 
question and 
double-click an 
image to see how 
much space it 
requires. You can 
also reduce the 
color setting of 
the image. 
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A Hands-On Tutorial 
This section provides a tutorial that will guide you step-by-step through the entire 
process to create a question bank using the ExamView Test Generator. You will learn 
how to create a variety of question types, save the bank, use a narrative, insert art, 
enter question information, and print a question bank. 
 
Create a New Question Bank 
1. Start the ExamView Test Generator program. 

2. Choose Create a new question bank from the Startup menu. 

If you are currently working in the test builder, choose Switch to Question Bank 
Editor from the File menu and then select the option to create a new bank. 

 

 

3. Name the question bank ExamView Sample Bank and click the OK button. 

An empty question bank page (except for the title) appears on your screen. If you 
want to edit the title, simply double-click it and change the title. 
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Enter True/False Questions 

1. Click the New button at the bottom of the window. 

2. Choose True/False and click the OK button. 

The question entry screen for a true/false question will appear. Depending on the 
question type, the entry screen provides different options. For example, the 
multiple choice screen includes space to enter each choice. 

3. Type the following question in the question entry area. 

Using ExamView you cannot create different versions of the same test. 

4. Use the pop-up answer box in the lower right corner of the window to set the 
answer to False. 
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5. Click the Info button at the bottom of the window. 

6. Type Easy for the difficulty, 221-223 for the reference, and click the OK button. 

7. Click the Record button. 

You should see the question you just entered on the 
question bank page. If you do not see the question 
information immediately after the question, choose 
Preferences from the Edit menu. Click the Layout 
tab and select the options to show difficulty and 
reference. 

8. Proofread the question. If you need to make any 
changes, double-click the question. Or, highlight it 
and click the Edit button at the bottom of the 
window. 

9. Create two more true/false questions using the following information. 
 
 

ExamView gives you almost complete control over the appearance of a test so 
that you can customize it to meet your testing requirements. 
 
ANS: T  DIF: Easy  REF: 245 
 
 
Stylized text, fonts, and special characters cannot be used in a test question. 
 
ANS: F  DIF: Challenging  REF: 237 

 
 
Save the Question Bank 

1. Proofread your work and make any changes as 
needed. 

2. Choose Save from the File menu. 

3. Enter a question bank file name, and select a 
location where you want to save the file. 

4. Quit the program, or continue with the next part of 
this tutorial. 

Be sure to save 
your question 
bank on a regular 
basis. From time 
to time, make a 
backup of your 
files. 

By default, all 
questions are 
assigned a value 
of 1 point. You 
can change the 
points in the 
Question Info 
window. 
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Create Multiple Choice Questions with a Narrative 

1. If necessary, start the program and choose to open the question bank for this 
tutorial. 

2. Click the New button, and choose to create a 
multiple choice question. 

3. Enter the following question, answer, and question 
information. 

 
Based on Table 1-1, ExamView 5 includes which 
feature? 
 
a.  QuickTest Wizard 
b.  Internet Test-Hosting 
c.  Select by Standard 
d.  All of the above 
 
ANS: D           DIF: Average           REF:  242-245 

4. Set the answer to d. 

5. Choose a-c in the Scramble box to scramble choices a-c only when you create a 
test, and set 1 for the columns. 

6. Click the Narrative button, click New, and enter the following narrative.  

 Use the Table menu to insert a table. If you have time, format the table as shown 
below. Center the information in the last two columns, shade the first row, and 
make the column labels bold. 

  
 ExamView 4.0 ExamView 5.0 

QuickTest Wizard Yes Yes 
Multiple Response No Yes 
Internet Test-Hosting Yes Yes 
Spell Check Yes Yes 
Select by Standard No Yes 

  Table 1-1 

7. Enter EV Table 1-1 for the narrative name and click 
the Record button. 

8. Click the Done button to return to the question 
entry window. 

You can also 
press Ctrl+N to 
create a new 
question. Or, 
choose New from 
the Question 
menu.  

It is important to 
use a unique 
name for each 
narrative you 
create. 
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9. Record the question. 

When you record the question, both the question and the narrative appear 
together. 

10. Enter the following question, answer, and question information. 
 

Based on Table 1-1, ExamView 4.0 does not include which feature? 
 
a.  QuickTest Wizard 
b.  Internet Test-Hosting 
c.  Select by Standard 
d.  Spell Check 
 
ANS: C           DIF: Average           REF:  242-245 

11. Click the Narrative pop-up (not the button) and choose the EV Table 1-1 narrative 
to link this question to the table you already created. 

12. Record the question, and be sure to save your work. 
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Enter Completion Questions and Run Spell Check  

1. Choose to create a new completion question. 

2. Enter the following question, answers, and question information. 

Notice that the question has three possible answers. For online tests, students can 
respond with any one of the answers. 

 
ExamView is a computer ____________________ 
that allows you to build paper and online tests. 
 
ANS: 
program 
application 
tool 
 
DIF: Average         REF: 247 
 

3. Enter the next question, answer, and question information. 
 
 

Use the online ____________________ whenever you need additional 
instructions to use the ExamView software. 
 
ANS: help              DIF: Easy            REF: 251 
 

4. After you record the question, choose Spell Check from the Edit menu. 

5. Save your work. 

Use the Shift key 
and hyphen to 
create the space 
to write an 
answer. 
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Create a Short Answer Question with a Picture  

1. Choose to create a new short answer question. 

2. Enter the following question, answer, and question information; but do not record 
the question. 

 
Describe the picture above. What format is used and how big is it? 
 
ANS:  Student answers will vary depending on the picture used. 
 
DIF: Average            REF: 277 

3. Insert one or two blank lines above the question, and move the cursor to the first 
line. 

4. Choose Picture from the Insert menu, locate a picture, and insert it into the 
question.  

If you cannot find a picture, start a paint program and create a simple illustration. 
Then, copy and paste the picture into the question. 

5. After you insert a picture, double-click the image and choose the Picture tab.  

This window shows the memory size for the image. You can also change the color 
settings here.  

 

 
 
 
 
 
 
 
 
 
 

 

6. Close the Format Picture window and record the question.  

Remember to 
keep the memory 
size of each 
picture as small 
as possible. 
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Wrap Things Up  

1. Save the question bank. 

2. Print a copy of the questions and review them. 

3. Make any needed changes.  

Remember that you can double-click a question or narrative to edit it. Or, you can 
highlight an item and click the Edit button. 

If you want, switch to the Test Builder using the File menu and choose to create a 
new test. Use the questions you just entered to build your test. Notice that as you 
build the test, the instructions automatically appear. 

4. Quit the program. 
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Copy and Paste Questions 

If you have questions in another format (e.g., word processor, another test generator, 
database, etc.), you can copy and paste questions from that program into the 
ExamView Test Generator. While this is a simple process, it can be time consuming. 
Usually, the copy and paste method is best for just a few questions. 

Note: If you have many questions in a word processor format such as Microsoft Word, 
you can use the import utility to import your questions quickly. Refer to the next 
section for instructions. 
 
To copy and paste questions… 

1. Choose to create a new question in a question bank or a test. 

2. Highlight and copy the text (e.g., from your word processor) that you want to paste 
into a question. 

3. Switch to the ExamView Test Generator question entry window. 

4. Paste the text into the question. 

Depending on the question type, you may have to copy and paste the question 
separately from the answer. However, you can quickly copy/paste multiple choice 
and multiple response questions. Using the SmartPaste option, you can 
automatically copy the choices into the appropriate places in the question entry 
window. 

To use SmartPaste, highlight an entire multiple choice or multiple response 
question including the choices (a. b. c. d. e.) in your word processor and select 
Copy. Switch to the question entry window and press F7 (not Ctrl+V or Paste).  

 
 
 
Import Questions from a Word Processor 

If you have all or most of your questions in a word processor format such as Microsoft 
Word, you can use the EV Import Utility (installed with the other ExamView programs) 
to import your questions into the ExamView Test Generator format very quickly. The 
program includes step-by-step instructions that explain how to import your questions.  
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WORKING WITH CLASSES AND ASSIGNMENTS  

The ExamView Test Manager provides the features you need to track results for paper 
and online tests. To begin, you must create a new class. Then, you can manually enter 
the student information or import a roster from another format such as your 
gradebook. Follow the steps in the appropriate section to create a new class and enter 
your roster. 

IMPORTANT: You do not have to create a new class if you do not plan to track student 
results or give online tests. 
 

Create a New Class 
Before you enter student information, you must create a new class. To do so, you must 
enter information about your class (e.g., class name, class ID, period, and section) and 
yourself (name, ID, school name, school ID, city, and state). Just a few of the fields 
are required. Other fields, such as the password and school ID, are optional. 

To create a new class… 

1. Launch the ExamView Test Manager. A startup 
window with two options will appear. Choose the 
Start a new class option. 

 If you are already working with the ExamView Test 
Manager, save the current class and choose New 
Class from the File menu. 

2. Enter the class name and other fields as needed.  

3. Enter your name, school name, city, and state. The other fields are optional. 

4. Click the OK button to record the class information. 

 
 

You can change 
the information 
at any time by 
choosing Class 
Information in 
h  di   
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Enter Student Names and IDs Manually 
After you create a new class, the next step is to enter your students. At a minimum, 
you must enter each student’s name and assign an ID. You may also enter an alias and 
a password. ExamView Test Manager provides an option to show the alias instead of 
the name and ID on reports. You can assign a unique password to each student to use 
when taking an online (LAN) test. 

 

ExamView Test Manager allows you to generate reports using optional demographic 
information such as gender, socio-economic factors, race, and custom fields (e.g., 
instructor, location, etc.). Simply click the More button in the New Student window 
to display the data entry fields to record this information. 

To enter student information manually… 

1. Continue from the previous section where you created a new class. Or, start the 
ExamView Test Manager to begin a new class or open an existing class. 

2. Click the  toolbar button or choose Add New 
Student from the Student menu. 

3. Enter the student’s first name, last name, and ID. 

 Note: If you plan to use a scanner, use digits only 
(e.g., 520403) for the ID. Most scanner forms 
provide for numeric IDs only. For online testing, use 
unique student IDs across all of your classes. To 
assign response devices, use the Custom 3 field 
(labeled Device ID by default). 

4. Click the Next button to record the student. 

 When you click the Next button the program records the student and clears the 
data entry field so that you can enter the next student.  

5. Repeat steps 3 and 4 to enter all of your students. 

6. Click the OK button when you are finished entering students. 

The alias and 
password fields 
are optional. 
 
Click More to 
view additional 
student fields. 
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Import a Student Roster 
ExamView Test Manager makes it easy to import your students from another file. At a 
minimum, the file must include the student’s first name, last name, and ID. The file 
must be a text file but can include the fields in any order along with other 
information. In just a few steps you can identify the pertinent information and start 
the import process. 

To import student information… 

1. Start ExamView Test Manager to begin a new class or open an existing class. 

2. Choose Import from the File menu. 

3. Select the .txt or .csv file that includes the students’ 
names and IDs. 

4. Click the pop-up menus in the First Data Record from 
File column to identify the data to import. 

5. Click the OK button to import the student 
information. 

 

You can import 
your class roster 
from another 
program such as 
your gradebook. 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 29   

Export a Student Roster 
ExamView Test Manager easily allows you to export your student roster for use in 
other programs. At a minimum, the exported file will include the student names. 
Choose to export your class roster as either a text file or, for the Professional Edition 
only, as a TurningPoint participant list. 

To export a class roster as text… 

1. Start ExamView Test Manager to open an existing class. 

2. From the File menu, choose Export then Class Roster as Text. 

3. Select the desired export options then click the OK button. 

4. Name the text file and select the save location. 

 

To export a class roster for TurningPoint… (Professional Edition Only) 

1. Start ExamView Test Manager to open an existing class. 

2. From the File menu, choose Export then Class Roster for TurningPoint. 

3. Name the text file and select the save location. 

The roster exports student last names, student first names, student IDs, and device 
IDs as a TurningPoint participant file (.tpp). 
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Create an Assignment 
Before you can score a test, you must first build it using ExamView Test Generator 
and then create an assignment in ExamView Test Manager. When you create the 
assignment, the ExamView Test Manager automatically opens the test file and reads 
the following information for each question (if available): answer, reference, learning 
objective, local standard, state standard, national standard, and points.  

To build a test and create an assignment… 

1. Start ExamView Test Generator, build a test, and save it. 

Automated scoring methods such as scanning or response device transmission only 
work with objective questions such as multiple choice and true/false. If your test 
includes open-ended questions such as short answer or essay, you must manually 
score those questions and record the points. 

Note: If you plan to administer multiple 
(scrambled) versions of a test, create one 
version, print it, and then save the file. 
Scramble the test to create the next version, 
print it, and save the test. For each unique test, 
you must create a separate assignment. 

2. Start ExamView Test Manager and choose to 
open a class. 

3. Click  from the toolbar, choose Create New Assignment from the Assignment 
menu, or click the New Assignment button. 

If your test includes 
objective and open-
ended questions, 
place the objective 
questions (e.g., 
multiple choice) at 
the beginning of the 
test. 
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4. In the New Assignment dialog, enter assignment name, category, term, and date. 

5. Choose the option(s) to identify how you will administer the test. Click the Next 
button. 

6. Select the file name that corresponds to the test 
you created in ExamView Test Generator. Click 
the Next button. 

 When you click the Next button, the program 
reads the answer key and other information that 
it needs to autoscore the test.  

 Note: If necessary, click the Folder button to 
locate your test.  

7. Review the summary information, and click the Finish button to complete the 
process. 

After you create the assignment, it appears in ExamView Test Manager work area. 
Notice the highlighted area in the figure below. The program shows the assignment 
title, date, category, term, and possible points. A placeholder (--) appears for each 
score. 

You will learn how to get results from a various sources in the following sections. 

You can click the 
Preview Test 
button to make sure 
that you are 
selecting the correct 
test. 
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SCORE PAPER TESTS WITH A SCANNER  

Using the ExamView Test Manager, you can easily score student assignments with a 
scanner. Currently, the program supports the following dedicated OMR scanners: 
Apperson Advantage™ 1200 and the Pearson/NCS EZData® scanner. In addition to 
dedicated OMR scanning, with the ExamView Assessment Suite Professional Edition 
you can use ordinary image scanners to perform plain paper scanning to score 
assignments. 
 

When you use a scanner to score your students’ tests, you… 

• Save time. 
• Get detailed results data. 

 

Saving time is an obvious advantage. Scanner technology makes it easy to score 
multiple choice, multiple response, and true/false 
questions. If a test includes both objective and open-
ended questions, you can score the objective questions 
with a scanner and then manually score the open-ended 
questions, recording the points earned for those 
questions. 

 

The primary purpose of the ExamView Test Manager is 
gathering detailed performance data to help you make 
effective decisions. A scanner provides a means to 
gather the data from paper tests to score your 
students’ work and generate various reports. If your tests include learning objectives, 
state standards, etc., you can then use that information to pinpoint areas where 
individual students need additional help. You can also use that data to identify trends 
for your entire class. 

 

IMPORTANT: 

• You must use specific forms with the scanners. Go to our website 
(www.fscreations.com) for a complete list of supported scanners and forms. 

• You can only score objective questions (e.g., multiple choice, multiple 
response, yes/no, and true/false) using a scanner. However, your test may 
include open-ended questions that you can score manually using the Edit 
Scores option. 

 

A scanner makes 
scoring 
assignments quick 
and easy. And, 
you get detailed 
results for your 
class. 
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Using Bubble Forms for Scanning 
After you create an assignment, the next step is to administer the test and have the 
students fill in their responses on bubble forms compatible with your scanner. 
 

For dedicated OMR scanners, ExamView-specific bubble forms must be used. These 
preprinted forms are ordered from the manufacturer. Refer to the Dedicated OMR 
Scanning section of this guide for details on supported scanner models, form numbers, 
and manufacturer contact information. 

 

For plain paper scanning (Professional Edition only), forms are printed directly from a 
laser printer from either the Test Generator or Test Manager. Refer to the Print a 
Bubble Form section in this guide for additional details. 

 

Plain Paper Scanning Notes… 

• Plain paper scanning only supports FSCreations bubble forms. 

• The bubble form must be installed into the copy of Test Manager where the 
results are being scanned. Verify that the form name appears in the list of 
forms displayed in the Print Bubble Form dialog. If the form name does not 
appear, visit the FSCreations website (www.fscreations.com) to download the 
form installer. 

• Forms should be printed on letter sized (8.5” x 11”) white paper at 100% scale, 
in portrait orientation only. Plain paper scanning does not support forms 
printed on other paper sizes, colored paper, or forms that have been scaled or 
printed in landscape orientation. 

• For best results, a laser printer is recommended for printing the bubble forms. 

• Forms must either be printed directly from ExamView or photocopied from an 
original printout. Do not use forms that are photocopied from a photocopy. 

• Verify that the forms are placed properly into the scanner ADF or flatbed. 
Check that the orientation of the image side of the form matches the direction 
specified by the scanner manufacturer. 

• Verify that the bubbles are properly filled in with dark marks and erasures are 
complete. 
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Dedicated OMR Scanning 
Dedicated Optical Mark Recognition (OMR) scanners are designed specifically for 
reading special bubble forms, ordered from the manufacturer. Scanning these forms 
reads the students’ responses for each question, stores this information for each 
student, and automatically calculates their score based on the point values assigned to 
the questions. 
 
The following OMR scanners and forms are currently supported by ExamView Test 
Manager and appear as options in the Get Results from Scanner dialog even if the 
hardware is not available. 
 
Apperson 
Scanner: Advantage 1200 
Forms: 2850, 2851, 2854 
 
Website: www.appersonedu.com 

Pearson/NCS 
Scanner: EZData 
Forms: 258936, 258937, 259402, 259404, 

259405 
Website: www.pearsonncs.com 

 

To get results from a dedicated OMR scanner… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that you will be scoring. 

3. Click the  toolbar button, or choose Get Results from Scanner from the 
Assignment menu. 

4. Select the OMR scanner from the drop-down list box. The option to Print correct 
answers on scanner sheet will automatically become enabled if it is a feature 
supported by the selected scanner model. 
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5. Select the connection port to which the scanner is connected, or click Detect 
Scanner to automatically set the port.  

6. Select the form used from the drop-down list box. The list of available forms will 
change depending upon the selected scanner model. 

7. Set the beginning question number and click Next. 

Tip: You can use the same forms for several assignments. For example, you can 
administer and scan a quiz with 10 questions. For the next quiz, set the beginning 
question number to 11 and have your students fill in the bubbles for questions 11-
20. 

8. Click Start Scanning to activate the scanning session. 

9. Scan the forms. 

If the student ID on the form does not match an ID in your class roster, the program 
will give you the option to select the student from your roster. 

10. Click Finish to accept the scores and return to the gradebook. 
 
 
General Notes… 

• Verify that the scanner is connected properly before you try to scan the forms. 
If you have trouble with the scanner, contact the manufacturer for support. 

• You may include up to 100 objective questions on a test. If you have more than 
100 questions, divide the test into two parts and create separate assignments.  

• Place the objective questions at the beginning of the test and number the 
questions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.). 

• If you have problem with a form, you can make corrections and then re-scan it. 
If necessary, you can manually enter the points earned. 

• You can include matching questions, but the choices are limited to the number 
of choices available on the selected bubble form. Check the form that you 
intend to use to be sure that the number of answer choices matches your test 
questions. Or, you can include matching questions and score the questions 
manually.  

• The software allows you to get results for an assignment from multiple sources. 
For example, you could administer a paper test to part of the class and an 
online test to other students. 

• You can scan forms in multiple sessions.  



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 36   

• If there are problems with a student’s form—missing responses, multiple 
responses, out of range (e.g., entering an E if only A-D valid), etc.—an asterisk 
(*) will appear next to that student’s name. Click the Stop Scanning button, 
highlight the student’s name, and click the Edit button. You can change the 
response for any item. Click the Start Scanning button to continue. 

 
 
Apperson Advantage 1200 Notes… 

• If the scanner becomes unresponsive, click the Stop Scanning button, press the 
Reset Options button (located on the scanner), and then click the Start 
Scanning button. If that does not solve the problem, cancel the scanning 
process. Turn the scanner off; turn the scanner on; and try to scan the forms 
again. 

• The Apperson scanner prints the percentage score on the scanner form. For tests 
with only objective questions all set to 1 point, the score will be correct. If your 
test includes open-ended questions, the score printed on the form will not 
reflect the open-ended questions. Unfortunately, there is no way to turn off 
printing. However, you can remove the print cartridges. 

 
 
Pearson/NCS EZData Notes… 

• If the status light turns an orange color, contact the manufacturer for 
assistance. A problem may occur if there is a conflict between the scanner and 
another hardware device. 

• If you notice that the information is regularly misreading student responses, 
follow the manufacturer’s guidelines for cleaning the scanner. 
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Plain Paper Scanning (Professional Edition Only) 
Plain paper scanning allows you to print bubble forms using an ordinary laser printer 
and scan the results using a TWAIN compliant image scanner. Because forms can be 
printed on-demand on standard sheets of paper, plain paper scanning provides great 
flexibility, convenience, and cost savings over dedicated OMR scanning. Additionally, 
the hardware required for plain paper scanning can be used for other purposes.  
 
Plain paper scanning reads the students’ responses for each question, stores this 
information for each student, and automatically calculates their score based on the 
point values assigned to the questions. 
 
IMPORTANT: 

• See our website (www.fscreations.com) for a list of image scanners that have 
been validated for compatibility with the plain paper scanning feature. 

• Although not required, it is strongly recommended that the scanner is equipped 
with an automatic document feeder (ADF) in order to be an effective tool for 
plain paper scanning. 

 

To get results from a plain paper scanner… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that you will be scoring. 

3. Click the  toolbar button, or choose Get Results from Scanner from the 
Assignment menu. 

4. Select the desired scanner from the drop-down list box. 

A separate entry will appear for every imaging device with TWAIN drivers installed 
on the computer. Some scanner manufacturers will install multiple drivers for a 
scanner, so multiple entries will appear in the list for a single scanner. Try to 
select the entry for the scanner that is most appropriate for the model and 
connection of your scanner. 

Tip: With plain paper scanning, there is no need to specify a form and an 
assignment does not have to be answered using the same form for all students. For 
example, you can administer a 50 question multiple choice test with most of the 
class using form FSC50AE, but give students with special needs form FSC50AE Jr. 
There is no need to sort the forms or specify which forms are being used. The form 
information is automatically read in from each sheet as it is scanned. 

5. Set the beginning question number and click Next. 
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Tip: You can use the same forms for several assignments. For example, you can 
administer and scan a quiz with 10 questions. For the next quiz, set the beginning 
question number to 11 and have your students fill in the bubbles for questions 11-
20. 

6. Load the forms into the scanner ADF tray or flatbed. 

Forms may be rotated 180 ۫ from each other but must be placed with the image sides 
properly facing the scanning surface. Check that the orientation of the image face 
of the forms matches the direction specified by the scanner manufacturer. 

7. Click Start Scanning to initiate session. 

8. Scan the forms. 

If the student ID on the form does not match an ID in your class roster, the program 
will give you the option to select the student from your roster. 

9. Click Finish to accept the scores and return to the gradebook. 

 
Notes… 

• Verify that the scanner is connected properly before you try to scan the forms. 
If you have trouble with the scanner, contact the manufacturer for support. 

• If you have more questions than can be accommodated on a form, divide the 
test into two parts and create separate assignments.  

• Place the objective questions at the beginning of the test and number the 
questions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.). 

• If you have problem with a form, you can make corrections and then re-scan it. 
If necessary, you can manually enter the points earned. 

• You can include matching questions, but the choices are limited to the number 
of choices available on the selected bubble form. Check the form that you 
intend to use to be sure that the number of answer choices matches your test 
questions. Or, you can include matching questions and score the questions 
manually.  

• The software allows you to get results for an assignment from multiple sources. 
For example, you could administer a paper test to part of the class and an 
online test to other students. 

• You can scan forms in multiple sessions.  

• If there are problems with a student’s for—missing responses, multiple 
responses, out of range (e.g., entering an E if only A-D valid), etc.—an asterisk 
(*) will appear next to that student’s name. Click the Stop Scanning button, 
highlight the student’s name, and click the Edit button. You can change the 
response for any item. Click the Start Scanning button to continue. 
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SCORE PAPER TESTS WITH RESPONSE DEVICES  

Using the ExamView Test Manager, you can easily score student assignments with 
response devices (Professional Edition only). Currently, the program supports the 
following devices: Turning Technologies ResponseCard® XL response pads with IR 
receiver (www.turningtechnologies.com). 

 

When you use response devices to score your students’ tests, you… 

• Save time. 
• Get detailed results data. 
• Engage students with technology. 

 

Similar to scanning results, response device technology makes it easy to score most 
objective questions (e.g., multiple choice, yes/no, and true/false). However, unlike a 
scanner, response devices do not support multiple response questions. If a test 
includes both objective and open-ended questions, you can score the objective 
questions with response devices and then manually score the open-ended questions, 
recording the points earned for those questions. Using response devices has the added 
advantage of engaging students with technology. Entering and transmitting answers 
with response pads is fun and easy! 

 

 

 

Assigning Response Device IDs 
In order to correlate the transmitted data with student records, response device IDs 
must be assigned to students. 

 

To assign a device ID… 

1. If the Student Information window is not already open, double-click the student 
you want to edit. Or, highlight the student and choose Edit Student Information 
from the Student menu. 

2. If the Optional Information fields are not already visible, click More to view the 
additional fields. 

3. Enter the response device ID in the third custom field, labeled Device ID by 
default. To assign device IDs to additional students, choose the student you wish to 
edit from the list on the left or click Previous or Next. 

4. When you are finished assigning device IDs to students, click Done. 
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Notes: 

• Enter the device IDs carefully. Because there is no standard format for device 
IDs, Test Manager does not validate the ID or check for duplicate entries in the 
class roster. When data is transmitted from a device, however, duplicate 
Device ID entries will generate an error. 

• The Device ID assignment uses the Custom 3 field of the Student Information. 
This field label can be renamed from the Student Preferences. However, Test 
Manager uses the Custom 3 field to find device IDs no matter what the label 
name may be changed to. 
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Get Results from Response Devices (Professional Edition Only) 
After you create and administer the assignment, students enter their answers into 
response devices then transmit the results directly into ExamView Test Manager. The 
program records the score for each student based on the point values assigned to the 
questions. Student results are saved for a detailed analysis of their performance. 

 

To get results from response devices… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that you will be scoring. 

3. Click the  toolbar button, or choose Get Results from Response Devices from 
the Assignment menu. 

Note: The gradebook window is completely hidden when the Get Results from 
Response Devices dialog is opened. This allows students to view the screen while 
transmitting their data to the receiver. 

4. Select the response device system from the drop-down list. 

Once a response device system is selected, ExamView Test Manager will 
automatically check that the proper receiver hardware is attached to the computer. 
The Next button will be disabled until a receiver is detected.  

5. Click the Next button to move to the next screen. 

6. Transmit the data from the response devices to the receiver. Student names and IDs 
are displayed in the dialog as their results are successfully transmitted. 

7. Click the Finish button to stop transmitting data and return to the gradebook. 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 42   

Notes: 

• The response device system software must be installed for it to appear in the 
list. For example, TurningPoint must be installed before the ResponseCard® XL 
devices will appear as an option. 

• If the response device system software is installed and the receiver is connected 
but fails to be detected, unplug and plug the receiver back in. 

• Once the Next button is clicked, do not unplug the receiver until the dialog is 
dismissed. 

• For successful transmission of data using the ResponseCard XL pads, students 
need an unobstructed line-of-sight path to the receiver. It is recommended that 
students approach the receiver one at a time and stand within 10 ft. of the 
receiver to transmit their results. The response pad must be directed straight at 
the receiver for the duration of the transmission, which should take no more 
than a few seconds. Failure to completely transmit the data will result in no 
name being added to the list. Students should simply re-transmit their data until 
their name appears in the list. 
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ADMINISTER ONLINE TESTS ON YOUR LOCAL AREA NETWORK  

The ExamView Assessment Suite includes all of the tools you need to create and 
administer online tests on your local area network (LAN). Use the online testing 
features to save time grading tests and generate the information to improve student 
performance. 

You can create online tests that anyone can take using your local area network (LAN), 
or you can assign a roster to an online test. For example, you can use ExamView Test 
Generator to create self-grading practice tests (or study guides) that provide feedback 
for incorrect responses. You can also use this testing option to administer chapter 
tests, quizzes, benchmark tests, homework, and worksheets. Then, use ExamView 
Test Manager to get results from an online test and produce reports. 

 

Before You Begin  
Before students can take tests using your local area network (LAN), you must get ready 
for online testing.  

1. Talk to your network administrator to secure space 
on your local area network to put the online tests. 

You and your students both need read/write (full) 
access to the network folder. 

2. Ask your network administrator to install the 
ExamView Test Player on your network and to place 
a shortcut on each workstation to access the 
program. Or, you can install the player program on 
each computer. 

 Advanced: You can create a shortcut for the program and set the target properties 
to include the following options. For example, set the target to 
c:\examview\evpro.exe /nobrowse. 

 /nobrowse This option turns off the option for students to change the path 
(or location) of the tests. 

 /noprefs This option directs the program not to write the preferences to 
the local computer. 

 /testpath= This option allows you to set the default path for the tests. 

3. Start ExamView Test Generator, choose Preferences from the Edit menu, and set 
the default online (LAN) path to the location on the network.  

Talk to your 
network 
administrator to 
get everything 
set up before you 
publish an online 
test. 
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Create an Online (LAN) Test without a Roster  
You can publish an online test with or without a roster for your students to take on 
your local area network (LAN). If you choose to publish a test without a roster, the 
program automatically scores the test. Anyone may take the test; however, the results 
are only available immediately after a student completes a test. No results are stored 
in ExamView Test Manager, and you will not be able to prepare any student/class 
reports. 

To create and publish an online (LAN) test that anyone can take… 

1. Start ExamView Test Generator and create or open 
a test. 

2. Click  from the toolbar or choose Publish Online 
Test from the File menu. 

3. Enter a test title. 

4. Choose the Publish the test to a local network for 
use with the ExamView Player option and click the Next button. 

5. Select the Allow access to anyone option and click the Next button. 

6. Follow the steps to set the remaining options (i.e., password, student feedback, 
question order, and reports) for the online test. 

 The program provides numerous options that allow you to customize the online 
testing experience for your students’ needs. Click the Help button to view detailed 
information about the online testing options. 

Results are not 
stored for online 
tests without a 
roster. These 
tests are great 
for practice tests 
and homework. 
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7. Review the test summary information and click the Save button to save the online 
test to your local area network (LAN). 

  

 

 

 Note: When you save the online test, the program saves a specially formatted copy 
of the test (with an .eot extension) to the location you specified. Remember that 
your students must access the test file on the local area network (LAN). If you saved 
the test to your hard drive, you must copy the online test (.eot, not .tst) to your 
network. 

8. If your test includes links to any multimedia files, you must copy those files 
manually to the same location as the online test. 

Students can now take the online test. See the Take a Test with the Test Player 
section. 

IMPORTANT: Preview the online test to make sure that everything is working. If you 
notice an error, make changes to the original test and publish it again. 

You can set the 
default folder 
using the 
Preferences 
option in the Edit 
menu. 
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Create an Online (LAN) Test with a Roster  
With the ExamView Assessment Suite, you can easily track student test results. When 
students take an online test, the program automatically scores the objective questions 
and stores the information in a database. Then you can produce a variety of reports 
and/or copy the results to your gradebook. 

 
To create an online test with a roster, you must first build and publish the online test 
using the ExamView Test Generator. Then, you must complete the process by 
creating an assignment in the ExamView Test Manager program. 

To create a test, publish the test, and track results for selected students…  

1. Start the ExamView Test Generator and create or open a test. 

2. Click  or choose Publish Online Test from the File menu. 

3. Enter a test title. 

4. Choose the Publish the test to a local network for use with the ExamView Player 
option and click the Next button. 

 

 

 

 

 

 

 

 

5. Choose the Allow access to students in a particular class option and click Next. 

6. Review the summary information and click the Save button to save the online test. 

 Note: When you save the online test, the program saves a copy of the test (with an 
.eot extension) to the location you specified. Remember that your students must 
access that location on the local area network (LAN). If you saved the test to your 
hard drive, you must copy the online test (.eot, not .tst) to your network. 

If you include 
open-ended 
questions, it is 
easy to score 
student responses 
manually. 
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7. If your test includes links to any multimedia files, you must copy those files 
manually to the same location as the online test. 

 

To assign an online test to a class… 

1. Start the ExamView Test Manager (if necessary). 

 After you publish an online test, you must complete the process by creating an 
assignment for that class. 

2. Open a class file. 

3. Click  or choose the Create New Assignment option from the Assignment menu. 

4. Enter the assignment name, category, term, and date. 

5. Choose the Online test delivered over a local area network (LAN) option to 
identify how you will administer the test. Click the Next button. 

6. Select the file name that corresponds to the test 
you published in the ExamView Test Generator. 

7. You can allow your students to complete the 
test multiple times or over multiple sessions. 
Select the appropriate option(s) and click the 
Next button. 

 If you allow students to complete an online test 
over multiple sessions, the program will save 
their work and let them continue where they 
left off in a prior session. 

Select an ExamView 
online test (.eot), 
not a regular test 
(.tst) file name. 
 
You can preview a 
test to make sure it 
is the right one. 
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8. Follow the steps to set the remaining options (i.e., password, student feedback, 
question order, time limit, and reports) for the online test. 

 The program provides numerous options that allow you to customize the online 
testing experience for your students’ needs. Click the Help button to view detailed 
information about the online testing options. 

 

 

 

 

 

 

 

 

9. Review the summary information and click the Finish button. 

After you create the assignment, it appears in the ExamView Test Manager work 
area. Notice the highlighted area in the figure below shows the assignment title, 
date, category, term, and possible points.  A placeholder (--) is set for each 
student’s score.    
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10. You should preview the online test to make sure that the test itself and online 
settings are correct. 

IMPORTANT: To preview a test with a roster, start the EV Test Player and use one 
of your student’s IDs to access the test. When you finish, go to the ExamView Test 
Manager. Open the class file, select the assignment, and choose the Get Results 
from a LAN Test option. You should see the score for that student. Next, highlight 
(select) the student record and choose Clear Student Results from the Student 
menu. Be sure to clear the results for only the test you just previewed. Be sure to 
choose the Update Online Tests option in the File menu to apply the updates to the 
online test. 

 

Notes… 

• You can assign the same online test to multiple classes. Simply open another 
class file and create an assignment. Point to the same online test when you 
create the assignment. Make sure that your students’ IDs are unique across all 
classes. 

• If you need to make any changes to the online settings (e.g., change the 
password, edit the reporting options, etc.), choose the Edit Assignment 
Information option from the Assignment menu.  

• If you notice mistakes in questions, misspelled words, etc. before any students 
take a test, make your changes to the original test and publish it again. 
IMPORTANT: You must delete the assignment from the class and then create a 
new one.  Otherwise, the answer key and other information will not match the 
online test. 

• If you notice mistakes in questions, misspelled words, etc. after any students 
take a test, you cannot make changes to the test. However, you can adjust the 
points earned to adjust students’ scores as needed. 

• If you identify an incorrect answer or point value, choose the Edit Assignment 
Information option from the Assignment menu. Click the Questions tab and 
change the information. You can change an answer or point value anytime 
without re-publishing the test.  These changes are not updated in the actual 
test, but they are applied to the students’ results. 
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Take a Test with the Test Player   
For tests that you administer on your local area network (LAN), students must use the 
ExamView Test Player to take the test. Before your students can take the test, make 
sure that the program is installed on your network and that students have read/write 
(full) access to the folder where the test is located. 

You can include any question type (multiple choice, true/false, numeric response, 
completion, essay, etc.) on an online test. The program automatically scores any 
objective (e.g., multiple choice), completion, or numeric response questions. You must 
manually score any open-ended (e.g., essay) questions as described in the next 
section—Get Results from a LAN Test. 
 

To take an online test… 

1. Start the ExamView Test Player program. 

2. Enter the student name and ID. Click the Next button to continue. 

 

 

 

 

 

 
 
 
 
 
 
 

3. Select the test and click the Next button. 

If you do not see the test listed, click the Folder 
button to change the location (if necessary). The 
program will show only those tests that the student 
may access. For example, if you set a date range 
when the test is available, you will not see the test if 
the current date is not in that range. 

If a student 
enters their ID 
incorrectly, no 
tests will appear 
in the list. 
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4. Review the test information and click the Start button to begin the test. 

 The ExamView Test Player displays one question at a time. Students can answer a 
question by clicking the radio buttons, clicking the choice buttons, or by typing a 
response. 

 

 

 

 

 

 

 

 

 

 

 The options available to the student depend on the online settings. For example, if 
you set the option to allow students to check their work, the Score button appears 
at the bottom of the window. If you set a time limit, a timer is displayed.  

 Get in the habit of previewing a test to make sure that you selected the appropriate 
settings. 

5. Respond to each question. Click the Next button or 
press Page Down to go to the next question. 

6. Click the End button when you are finished. 

 Depending on the reporting options you set, a report 
will appear.  

7. Click the Exit button to quit the program, or click 
the New button to start a new test.    

You can set an 
option to show 
the end-of-test 
report and 
whether students 
can print the 
report. 
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Get Results from a LAN Test 
After your students take an online test, the next step is to get the results into the 
ExamView Test Manager. When you perform this step, the program reads the results 
and stores the data in the class record. If your test 
includes open-ended questions, you must manually score 
the questions and record the points earned. 

To get results from a LAN test… 

1. Start the ExamView Test Manager program. 

2. Select (highlight) the assignment for which you want 
to get results. 

3. Click  or choose the Get Results from LAN Test option from the Assignment 
menu. 

The program automatically locates the online test file (with an .eot extension) and 
reads the results from it. If you moved the file, you must locate it. 

4. If your test included open-ended questions or you need to change a student’s score, 
select the assignment and choose the Edit Scores option from the Assignment 
menu.  

 The Edit Test Scores window shows you how your students answered each question 
and the points earned. Select a student. For open-ended questions, select a 
question. The student’s response appears for your review. Read the response and 
enter the points earned. Click the Next button to move to the open-ended question 
for the next student. You can change the points earned for any other question too. 

  

 

 

 

 

 

 
 

 

Remember, that 
student results 
are stored only 
for online tests 
that you assigned 
to a class. 
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PUBLISH A TEST TO THE LEARNING & TEST CENTER  

Using the ExamView Test Generator, you can publish an online test in several ways. 
One of those ways is to publish a test/assignment directly to an Internet test-hosting 
service called the Learning & Test Center. A test-hosting service offers these 
advantages: (1) publish to the Internet with just a few mouse clicks; (2) results 
tracking and reporting; (3) control over when and who takes a test; and (4) no 
additional hardware or maintenance costs. 

FSCreations, Inc. (the developers of the ExamView Assessment Suite) offers an 
optional test-hosting service on an annual subscription basis. For more information and 
pricing, visit our website at www.fscreations.com. 

With the Learning & Test Center, you can… 

• Publish a self-grading practice test in just a few steps that your students can 
take from anywhere they have access to a computer and the Internet. 

• Administer homework and automatically score it without any additional effort 
on your part. 

• Deliver benchmark tests to a class or an entire school. 
• Produce numerous reports that let you track student performance by standard. 

Other companies may offer an online service. Check with your sales representative 
or visit their website for more details. If you do have access to a third-party service, 
follow the steps below to publish a test. However, be sure to choose the appropriate 
option from the Publish test to: pop-up menu. After you publish the test, refer to 
the instructions for that service to administer the assessment. IMPORTANT: You will 
not use the ExamView Instructor Center or Learning & Test Center to administer 
tests published to another service.  

 

Register for the Learning & Test Center 
Before you use the ExamView Learning & Test Center, you must purchase a 
certificate number and then use it to register for an account. When you register, you 
receive an instructor ID and a password. 

To register for an account… 

1. Visit www.fscreations.com/examview.php and click 
the Instructor Center link. 

2. Click the Register link and follow the instructions to 
sign up for the service. 

Be sure to record your instructor ID and password. 
You will also receive an email with this information. 

3. Quit the browser when you finish. 

After you register 
online at the 
FSCreations 
website, you can 
change your ID 
and/or password. 
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Publish a Test or Assignment 
Publishing a test/assignment (regular or self-scoring) to the ExamView Learning & 
Test Center is a very simple process. Within minutes, you can create a test or an 
assignment for students to take online. Test or homework results are available 
immediately after your students complete the assignment. 

To publish an assignment… 

1. Start the ExamView Test Generator, and create or 
open a test. 

2. Click  or choose the Publish Online Test option 
from the File menu. 

3. Enter a title for the test/assignment. 

4. Select Publish test to: with the pop-up showing 
ExamView Learning & Test Center Website. Click 
the Next button to display the log in screen. 

5. Enter your instructor ID and password, and then click the Next button. 

6. Select the option to determine who may access the test. 

You can allow anyone to take the assignment or control access to students in a 
particular class. If you do not care about getting student results or how many times 
a student completes an assignment, allow access to anyone. 

If you want to track your students’ results, you must assign a class. You can create a 
roster or import student names and IDs from another file. 

7. Set a password for the assignment and click the Next button. 

If you have an 
account with 
another service, 
select it from the 
Publish to: pop-
up and enter the 
appropriate ID 
and password.  
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8. Select the remaining online options.  

9. Review the summary information, and click the Publish button to upload the 
assignment to the website. 

After you publish the assignment, you will receive an email that confirms you 
published the assignment successfully. The email also includes instructions that you 
can provide to your students. 

 
 

After you publish 
an assignment, 
you can preview 
it and edit many 
of the settings 
online at the 
Instructor 
Center.  
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Access the ExamView Instructor Center 
The ExamView Instructor Center provides access to tests you publish via the test-
hosting service. Access the Instructor Center using a web browser on any computer 
connected to the Internet.  

Using the ExamView Instructor Center, you can… 

• Preview a test/assignment. 
• Change selected test settings. 
• Edit, change, or delete students. 
• Access numerous student reports. 
• Delete tests. 
• Update your account information (ID, password, email address, etc.). 

 

To access the ExamView Instructor Center… 

1. Go to the www.fscreations.com website. 

2. Click the Instructor Center link. 

3. Enter your instructor ID and password to log in to the Instructor Center. 

4. Link to the desired option to manage tests, view reports, update account 
information, etc. 
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Complete a Test/Assignment via the Internet  
Students can take a test or complete an assignment using any computer (Windows or 
Macintosh) connected to the Internet (e.g., at school, in a 
lab, or at home). When you are ready for students to work 
online, direct them to the www.evtestcenter.com 
website.  

To take an online test or complete an assignment… 

1. Go to the www.evtestcenter.com website. 

2. Enter the Instructor’s ID. 

After you log in, you will see a list of the available 
tests/assignments. 

3. Highlight an item and click the OK button. 

4. Enter the student ID or name, and enter the password. 

IMPORTANT: If you published a test/assignment with a roster, your students must 
enter the ID you assigned to them. If you allowed anyone to access the assignment, 
students must enter their name. 

5. Complete the test/assignment. Click  to submit and/or view the 
results. 

When you publish 
an assignment, 
you get an email 
with a link to the 
test. Students 
can use that link 
to skip the log in 
process.  
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Get Results from an Internet Test/Assignment 

Using the ExamView Test Manager you can download results from the Instructor 
Center to your desktop. Then, you can produce reports using the reporting options 
provided in the ExamView Test Manager. You can combine results from all of your 
assignments (paper, LAN, or Internet) into one convenient location. 

Before you can download the results, publish your test/assignment with the ExamView 
Test Generator using the various online settings described in the previous sections. 
Administer the test or homework assignment to your students. 

IMPORTANT: Getting the results from an Internet test is optional since you can access 
many reports online at the ExamView Instructor Center. With the test-hosting 
service, you can view student results and generate numerous reports online. You do 
not have to download the results into the ExamView Test Manager. 

To get results from an Internet test/assignment… 

1. Publish and administer a test/assignment to the Learning & Test Center. 

2. Start the ExamView Test Manager (if necessary) and open a class.  

3. Create an assignment if you have not already done so. Enter the assignment 
information and identify the test (.tst) for the program to read the answer key and 
other question information (standards, references, etc.). 

4. Highlight the assignment. Click  or choose Get Results from Internet Test. 

5. Enter your instructor ID and password, and click Next. 

6. Select the Internet test from the list provided and click Finish to get the results. 

 The ExamView Test Manager downloads all of the students’ responses and results 
from the Internet test-hosting site. If your test includes open-ended questions or 
you need to change a student’s score, select the assignment and choose the Edit 
Scores option from the Assignment menu. 

 

Notes… 

• When you publish an assignment, be sure to save a copy locally on your 
computer. The assignment you publish online must match exactly the one you 
use to create an assignment in the Test Manager. 

• You can administer a test using any combination of paper, local area network 
(LAN), or Internet testing options. 

• Unlike tests administered via a LAN, you cannot change the settings in the 
ExamView Test Manager. You must make any changes to these settings and the 
class roster online at the Instructor Center.  
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PREPARE REPORTS FOR PAPER AND ONLINE TESTS  

The ExamView Test Manager enables you to prepare a variety of reports based on 
your students’ assignment results data. You can print a report for a single assignment, 
a group of assignments, or all assignments. You can also easily customize a report to 
include selected students filtered by various criteria. Many of the reports include 
graphs and charts that provide a visual analysis of the data. 

 

Use the ExamView Test Manager to generate the following class and reports. 

 

Class Reports 
Assignment Results 
Class Assignment Summary 
Open-Ended Responses Worksheet 
Item Analysis Summary 
Class Roster 
Learning Focus 
Performance Summary 
Class Performance Progress Chart 
 

Student Reports 
Assignment Results 
Assignment Review 
Student Progress Report 
Learning Focus 
Performance Summary 
 

 

For each report, you can choose reporting options to control the information included 
in the report. Using the filter option, you can generate reports for selected students or 
a group of students that match the criteria you set.  
 
 
Class Reports 
The ExamView Test Manager provides numerous reports to help you understand and 
evaluate your students’ performance. Depending on your needs, you may prepare one 
or more of the class reports to provide useful performance data that allows you to 
assess your class as a whole and then determine appropriate strategies to achieve the 
learning objectives/standards. With each report, you can control numerous reporting 
options to customize the report as desired. This section includes a brief overview and 
a sample of each class report. 
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Assignment Results 
The Assignment Results report provides performance data for each student for a 
particular assignment. The report includes the student’s name, ID, points earned, and 
percentage achieved. For online test, the report also includes attempts to complete 
the assignment, the start time (date and time), and the duration of the assignment 
(i.e., the total time to complete the assignment).  

 

The report also includes a separate page with the assignment statistics for the entire 
class (i.e., median, mean, low score, high score, range, and standard deviation) and a 
graph of the frequency distribution. When you choose this report, you can control 
various reporting options. For example, you can choose to show all of the student 
information or you can include the ID or alias for each student.  

 

Using the statistical data in the Assignment Results report, you can see how the 
majority of the students performed on the assignment. The duration data provides 
useful information for future reference; you can calculate the approximate amount of 
time required for the students to complete the assignment. Finally, you might use the 
Assignment Results report to post the results of an assignment. 
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Class Assignment Summary 
The Class Assignment Summary report provides the average for each student for all 
assignments or for a particular category (i.e., tests, quizzes, etc.) of assignments. You 
can summarize the data for all terms or one term. For example, you can create a 
report that shows each student’s average for all tests in the first term.  

 

Over time, the Class Assignment Report provides useful data to help you assess the 
performance of your class as a whole. From this information, you might be better 
equipped to assess the effectiveness of your teaching strategies and the associated 
assignments as they relate to the learning objectives/standards for the class.  

 

Note: In the Class Assignment Summary report, the shaded area ( ) shows the 
median performance range for the class and the diamond ( ) shows the exact student 
average. 
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Open-Ended Responses Worksheet 
The Open-Ended Responses Worksheet report allows you to score the open-ended 
questions that your students complete as part of an online test. Follow these steps to 
score open-ended questions and enter the scores into the ExamView Test Manager.  
1. After all of your students finish an online test, use the option to get the results 

into the ExamView Test Manager. This process reads all of the student responses 
for the assignment including the open-ended questions (essay, short answer, etc.). 

2. Print the Open-Ended Responses Worksheet. The report includes the open-ended 
responses for each student and space for you to write the points earned for each 
question.  

3. After you complete the worksheet, use the Edit Scores option to enter the results 
into the program. 

You can use the Open-Ended Responses Worksheet report to work away from your 
computer. You can score open-ended questions anywhere and then enter the scores 
into the ExamView Test Manager at a convenient time. 

 

 

 

 

 

 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 63   

Item Analysis Summary 
The Item Analysis Summary report provides the percent of the class that answered 
each question correctly. For multiple choice questions, the report also shows the 
percent of the class that selected each response (or answer choice).  
 
You can use the response analysis in the Item Analysis Summary to identify areas in 
which you may want to focus a re-teaching activity so that you can better address 
particular learning objectives/standards. For questions with a high, correct response 
rate, you can use the information to validate the question. On the other hand, if 
students consistently answered a question incorrectly, you can assess whether this 
points to a problem with the question. For example, suppose students answered a 
question overwhelmingly (e.g., 60%) with an incorrect response. This may have 
occurred because you recorded an incorrect answer for the question, the question was 
unclear, or you did not cover the information adequately in class. 
 
If, in a particular multiple choice question, the student responses are evenly 
distributed for all of the answer choices, the analysis may indicate that students 
randomly selected a response. If, in another multiple choice question, students 
selected the correct response at 65% followed by 30% for the next response. This 
response analysis data may point to a common mistake students made in determining 
the correct answer for the question. On a question-by-question basis, you should look 
for similar patterns; such information can provide insight into your students’ 
understanding of the material covered by the assignment.  
 
Note: In the Item Analysis Summary report, an indicator (>) appears to the left of a 
question that more than 30% of the students in the class answered incorrectly. 
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Class Roster 
The Class Roster report generates an alphabetical list of the students in a particular 
class. You can create a filter to include all of the class or selected students. 
Additionally, you can customize the Class Roster report by choosing to include the 
supplemental student information (i.e., ID/alias, password, grade, date of birth, 
sociological/economic, etc.). 

 

You might use this report to have a printed record of the ID/alias and password for 
each of the students in each class. You could then conveniently reference this printout 
if a student forgets their ID, alias, or password. However, to maintain privacy of the 
IDs, you would want to keep the printout in a safe place where students and others 
could not access the information. 
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Learning Focus 
The Learning Focus report provides a wealth of information to help you identify areas 
where your class (as a whole) needs to focus their learning efforts. To use this report 
effectively, the assignments you create must consistently include data for one or more 
of the following fields: learning objective, local standard, state standard, or national 
standard. 

 

One of the key advantages for using the ExamView Test Manager is that you can easily 
gather performance data over multiple assessments. The report shows the number of 
items for each standard. That way, you can gauge whether a standard was adequately 
covered. You can select one or more assignments by category or by date. You must 
also identify a focus range (e.g., 0% - 70%). The program produces a report that shows 
each standard (or learning objective), the number of questions assessed for that 
standard, class average, and how many students are in the focus range. 

 

Note: The shaded area (  ) shows the performance for the median 70% of the 
students in your class. For example, if there are 20 students in your class, the top 3 
scores (15%) and lowest 3 scores (15%) would not be included. The range of scores 
represents 14 students or 70% of the class. The diamond (  ) shows the actual class 
average. Use the graphs to see how the majority of students performed. If the area is 
relatively short, students’ scores were similar. 
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Performance Summary 
The Performance Summary report provides a summary of your class’ performance for 
all class assignments in a category over a specified date range. The Performance 
Summary report lists a learning objective/standard, the number of items (i.e., 
questions) that assess that objective/standard, and the proficiency level that the class 
as a whole has attained.  

 
To use the Performance Summary report effectively, you must consistently include 
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

 
You can customize the Performance Summary report to generate the performance 
data that best meet your needs. You can select the date range for the class 
assignments, and you can set an appropriate proficiency target (e.g., 70% and above) 
for the class assignments at a particular time in the term. As an example, you might 
set the proficiency target at 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the proficiency target at 80%. 
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Class Performance Progress Chart 
The Class Performance Progress Chart report shows at a glance how each student is 
performing on each of the learning objectives/standards for all assignments in a 
category over a specified date range. The report lists a learning objective/standard, 
the number of items (i.e., questions) that assess that learning objective/standard, and 
a proficiency indicator for each of the students.  

 
To use the Class Performance Progress Chart report effectively, you must 
consistently include question information for one or more of the following fields in 
each of the items you create: learning objective, local standard, state standard, or 
national standard. (Many publishers include this information for the questions they 
provide.) 

 
To customize the Class Performance Progress Chart, you can set the category of 
assignments, the date range of the class assignments, and the proficiency level based 
on your performance criteria. The report shows one of three icons ( ) to 
indicate each student’s performance on each of the learning objectives/standards. 
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Student Reports 
The ExamView Test Manager provides five reports that highlight each student’s 
individual performance for one or more assignments. This section includes a brief 
overview and a sample of each student report.  

 

Assignment Results 
The Assignment Results report reflects a student’s performance for one assignment. 
The report includes the following information: assignment average, points earned for 
each question, and the student’s response for each question.  

 
If you select the option for performance results for learning objectives/standards, the 
Assignment Results report also includes each learning objective and the following 
performance data for that learning objective/standard: the average, points earned, 
the proficiency level, and the specific questions in the class assignment. To use the 
Assignment Results report effectively, you must consistently include question 
information for one or more of the following fields in each of the items you create: 
learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

 

You can use this report to identify each student’s proficiency level for each of the 
learning objectives/standards for each assignment. This information may also help you 
to identify areas in which a student may need remedial work. 
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Assignment Review 
The Assignment Review report provides a tool to help your students understand the 
mistakes they made on an assignment. For each question answered incorrectly, the 
report shows the following: points earned, student’s response, correct answer, 
explanation, study tip, and focus area (depending on the information available). 
  

To use the Assignment Review report effectively, you must consistently include extra 
question information for each of the items you create. (Many publishers include this 
information for the questions they provide.) For example, a study tip such as Refer to 
pp. 23-25 is the information in the Reference field for a question. Students, in this 
example, could use the report to refer to the specified pages in their textbook as they 
review the questions that they answered incorrectly. 
 

Students can use the Assignment Review report to review the completed assignments 
and to learn from their mistakes. 

 
 

 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 70   

Student Progress Report 
The Student Progress Report shows a student’s progress for one or more terms. The 
report organizes the results by term and provides the following information for each 
assignment: assignment description, date assigned, category, points earned, percent 
achieved, and class average. A summary shows the term average by listing the total 
points earned out of the total possible points, the equivalent percent, and the class 
average.  
You can use the Student Progress Report to depict the student’s progress over time. 
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Learning Focus 
The Learning Focus report identifies areas where a student needs to focus his/her 
learning efforts. Based on a proficiency level you set, the report lists the learning 
objective/standards that a student has not mastered. For each of the learning 
objectives/standards the student has not yet mastered, the Learning Focus report 
lists the learning objective/standard, the associated number of items, the points 
earned on items, and the proficiency level that the student has attained.  
 

You can customize the Learning Focus report to generate the performance data that 
best meet your needs. You can select one or more class assignments by category and 
the date range for the assignments. You can set an appropriate focus range (e.g., 0% - 
70%) for the class assignments at a particular time in the term. As an example, you 
might set the focus range at 0% to 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the focus range to 0% to 80%. 
 

You can use the Learning Focus report to help a student know exactly what to study 
in order to attain mastery level on the identified learning objectives/standards.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Note:  The shaded area (  ) shows the performance for the median 70% of the 
students in a class. For example, if there are 20 students in a class, the top 3 scores 
(15%) and lowest 3 scores (15%) would not be included. The range of scores for 14 
students (70%) would be represented. The diamond (  ) shows your student’s actual 
performance. Use the graphs to see how a student performed in relation to his/her 
class. For example, if the diamond appears near or past the right edge of the shaded 
area, the student’s performance is in the upper range for the class.  If the shaded area 
is relatively short, students’ scores were similar. 
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Performance Summary 
The Performance Summary report shows at a glance how a student is performing on all 
learning objectives/standards for all assignments in a category over a specified date 
range. The Performance Summary report lists each learning objective/standard, the 
number of items (i.e., questions) that assess each learning objective/standard, a 
proficiency score for each learning objective/standard, whether the student is 
proficient based on the proficiency target, and the average for each learning 
objective/standard.  

To use the Performance Summary report effectively, you must consistently include 
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

You can use the Performance Summary report to identify specific learning 
objectives/standards where the student needs to focus his/her learning efforts.  

 
 



  
  

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 73   

Print a Report 

After ExamView Test Manager prepares a report, you can print the report in just a 
few simple steps. When you are ready to print a report, follow these general 
instructions. Numerous report options allow you to customize the information that 
appears on the printout.  For detailed instructions and options, see the corresponding 
help topic in the application. 

To print a report… 

1. Click the Report menu and choose a report. 

2. Select the report options. 

3. Click the OK button to display the report. 

4. While viewing the report, click the Print button to 
send the report to the printer. 

 

 

Export Results to a Gradebook or Another Application 
The ExamView Test Manager lets you export the students’ results data for an 
assignment. You can export summary data (e.g., student name, ID, and percentage) or 
detailed data (e.g., student information, all responses, answer key, etc.). With the 
export option you can export student results in order to import them into your 
gradebook or a spreadsheet. For more advanced users, you can export the results for 
use with a student information system. 

To export the results for an assignment… 

1. Select an assignment. 

2. Choose Export and then select the Current Assignment as Text or Current 
Assignment as XML option. 

 Use the as Text option to export results for use with a gradebook or a spreadsheet 
program. Use the as XML option to export results to a student information system. 

3. Set the options (if necessary) and then enter a file name. 

Note: You can also use the Copy All Class Records option in the Edit menu to copy 
all of the information in the work area.  Then, you can paste that information into a 
spreadsheet document. 

You can set a 
filter to print 
only selected 
students based on 
various criteria.  
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PUBLISH AN INTERNET (HTML) TEST TO YOUR OWN WEBSITE  

Using the ExamView Test Generator, you can publish any test as an HTML document. 
You can choose to create a self-grading study guide or a test that will send student 
results to you via email. After you publish the test, you must copy the files to your 
website so that your students can access the test. 

Publishing an HTML test is a quick way to create an 
online test. However, these disadvantages exist: (1) you 
must have your own website and know how to upload 
files; (2) there are no settings to control when and who 
may access a test; (3) results are not stored in a 
database for access at a later time; and (4) getting 
results via email can be unreliable due to network 
settings and spam filters. 

For many situations, the HTML testing features provide a 
an acceptable solution to meet a variety of online testing needs. Review the 
instructions in this section to learn how to publish an Internet (HTML) test. 

 

Publish an Internet (HTML) Test 
Follow the instructions below to set the features for the online test and save it to your 
hard drive. 

To publish an Internet test… 

1. Start the ExamView Test Generator and create or open a test. 

2. Click  or choose Publish Online Test from the File menu. 

3. Choose the  Save the test as an HTML document to your hard drive option. Click 
the Next button to display the test options. 

 

 

 

 

 

 

 

The ExamView 
Test-Hosting 
Service provides 
a more robust 
Internet testing 
and study 
solution. 
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4. Choose to publish a study guide or a test and click the Next button. 

 A study guide is a self-grading test. You can choose 
to show the rationale, feedback, and reference if 
your test includes this information. Doing so makes 
the study guide a true learning experience rather 
than just telling the students that an answer is right 
or wrong. 

 Choosing a test allows students to take it online, and 
you receive a separate results email for each student. You must include a valid 
email address. You also have the option to show a student his/her results after 
completing a test.  The results email will contain the student name and his/her 
score. 

5. Click the Save button to save the HTML document and image files to your hard 
drive. 

When you publish an online test, the ExamView Test Generator saves an HTML file 
and all of the supporting images. The images are stored in a folder named similar to 
the test file.  

 
 

 

 

 

 

 

 

 

6. Copy the HTML file and the folder with its contents to your website. Do not change 
anything including the folder name. 

 

Note: If you do not know how to copy files to your website and set a hyperlink, 
contact your technology support person. The process varies depending on your 
particular system. 

7. Preview the test before your students take it.  

For tests, answer some or all of the questions. Then, click the Grade & Submit 
button and make sure that you receive a results email. It’s very easy to enter the 
wrong email address. Doing so will cause you to not receive any emails. 

 

Student feedback 
can include a 
hyperlink to 
remedial learning 
material. 
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Take an Internet (HTML) Test 
After you publish an HTML test and copy it to your website, your students can take the 
test anytime from anywhere they can access the Internet. You must provide your 
students with the website address (URL) for them to access the test. 

To take an Internet test… 

1. Start your web browser. 

2. Enter the website address to go directly to the test or to a page with a hyperlink to 
the test.  

 

 
 
 
 

 

 

 

 

 

 

 

 

 

3. When the test appears, enter your name (and email/ID if requested).  

4. Complete the test. 

5. When you finish your online work, click the Check Your Work button for a study 
guide or the Grade & Submit button for a test. 

Note: For a test, you will receive a results email for each student shortly after the 
student clicks the Grade & Submit button. 
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EXPORT TESTS TO WEBCT AND BLACKBOARD  

The ExamView Assessment Suite works with both the WebCT and Blackboard course 
managements systems. You can easily upload a test from the ExamView Test 
Generator to either one of these applications. Simply open your test or question bank, 
choose to export it, and a wizard will guide you through the process. 

                                     

 

To export a test or question bank… 

1. Start the ExamView Test Generator and create or 
open a test or question bank. 

2. Choose Export from the File menu, and select 
either WebCT or Blackboard. 

3. Follow the instructions in the wizard to upload the 
test/question bank. 

 

IMPORTANT: For step-by-step instructions, click the Help button that appears while 
you are working with the wizard. 
 

Be sure to check 
the FSCreations 
website for free 
updates to the 
export program. 
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APPENDIX  

Technical Support 
Before seeking technical support, please check the following: 

• Is your computer working properly? Try some other software, which you know is 
working, on the same computer. 

• Try the software on another computer. 

• Can you repeat the problem? Does the problem occur at the same point each 
time? 

In order to help you as quickly as possible, have the following information available 
before you contact technical support: 

• Version of the software (e.g., 5.1.0) from the start-up splash screen or from the 
About ExamView… screen (accessed from the Help menu) 

• Brand, model, and configuration of the computer you are using 

• System version (Windows XP, Windows 2000, OS X 10.2, etc.)  

• The exact wording of any error message 

Visit our online support forum (forum.fscreations.com), for quick answers to most 
product questions. Topics on the forum cover everything from explaining product 
features to licensing and purchasing options. The active user community also provides 
useful solutions and product tips on the forum. 
 
If you cannot find a solution to your problem on the forum, contact a technical support 
representative by telephone or email. FSCreations provides technical support for the 
ExamView Assessment Suite Professional Edition. For the non-Professional Edition, 
contact your publisher for support. Refer to your publisher’s website to obtain the 
technical support contact information.  
 

 

Using the ExamView Assessment Suite with Other Applications 
Many other products work with the ExamView Assessment Suite software and its 
content. For example, you can deliver a practice test that works with a quiz show 
program or use the test on a handheld (e.g., Palm or PocketPC). The ExamView 
Assessment Suite also works with several bubble sheet OMR scanners to make grading 
your tests quick and easy. 
 
For a complete list of the products that work with the ExamView Assessment Suite, 
visit the FSCreations website (www.fscreations.com). 
 


